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Introduction to Excel, Part II:
By Christopher Schnaars

The Morning Call

Where Are We Going?
This is the second of a four-part series of handouts to teach basic and intermediate skills
in Microsoft Excel.

What Are We Going to Learn?
We're going to learn some helpful ways to move around your data. We'll look at how to
display information from different parts of your sheet at the same time, how to protect
your data and how to print your work. We'll also have a basic math lesson looking at the
different ways to calculate an average, and we'll look at subtotals, rankings, rates and
where to go for help.

Much of this lesson is going to fly through a lot of tips. Try out the mouse clicks and
menu selections for the ones that sound useful or interesting to you and feel free to gloss
over the rest.

Worksheets
If you recall, the Excel file you are working with is a workbook comprised of one or
more worksheets. If you find yourself using only one sheet most of the time, you can tell
Excel to default to only one sheet. Go to Tools, then Options in the Menu Bar and click
the General tab. There is a "Sheets in new workbook" option here.

You can name a sheet whatever you want.
(You can even choose a different color, if
your right brain is so inclined.) Just
double-click the name of the sheet on the
tab at the bottom of your screen, such as
Sheet1, or right-click this tab and select
Rename. You also can change the order
of sheets by just dragging the tabs to the
order you want.

To insert a new sheet, right-click the tab where you want to insert the sheet and choose
Insert. Similarly, you can right-click and Delete a sheet you don't need.
Finally, you can copy an entire sheet. Right-click the sheet, and select "Move or copy."
From the window that opens you can select where you want to move this sheet. If you
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want to copy a sheet rather than just move it, check the box at the bottom of the window
before you hit OK.

Keeping Your Column Headings Visible
Open the budget file that you were working with in Part One of the tutorial. This file is
small enough that you can see all of your data at once. Scroll down to Row 100 (even
though there is no data in that Row). Now what if you wanted to type something in the
Pct Change column? Do you know which column that is without scrolling back to the top
to see your column headings?

Most of the time, you will want to make sure your column headings and everything in
Column A stay visible all the time. That way, no matter where you are in the sheet, you
can easily tell what is in each column and each row.

To do this, you first need to click on the first cell that you don't mind scrolling out of
view. In this case, we want everything in Row 3, because those are our column headings
and everything in Column A because that is the name of our city departments and
revenue sources. So the first cell we don't need to see all the time is B4. Click this cell, go
to your Menu Bar and select Window, then Freeze Panes.

Notice that thick black lines
are drawn above and to the
left of Cell B4. Now try
scrolling down your
document and to the right.
No matter how far you go,
all cells above and to the
left of those lines remain
visible.

This doesn't help us
entirely, though, because
we can't see the column
headings for Revenues.
There are two ways to deal
with this. The first is to
split the window. Go to
your Menu Bar and select
Window, then Split. This
changes the black lines to

thicker grey lines. This basically splits the worksheet into four windows, allowing you to
view up to four areas of your sheet at the same time.

We really only need to view two areas, so double-click the thick vertical grey line
between columns A and B to get rid of it. You also can drag these lines to make a section
larger or smaller. Go to the top section and scroll down until Row 20 is at the top of the
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screen, then drag the grey bar down seven rows so we can see the entire Revenues
section. Now we can click on the lower section and move around the expenditures
portion of the budget. The revenues will remain visible on top.

This screenshot shows a worksheet that has been Split so two portions are visible at the same time. You can
view up to four sections at once (with one horizontal divider and one vertical divider). You cannot, however
Freeze Panes while your panes are Split.

There is one more option that is new in Excel 2003. If you are using this version, go to
Window in the Menu Bar and select New Window. Now look at the file name in the dark
blue bar at the very top of your screen. It shows :2 after the file name. Your file now is
open in two separate windows.

To easily see both at the same time, go back to Window and select "Compare side by side
with." A dialog box will open, and you'll see you can select the same file with :1 after the
file name. When you click OK, both windows will be displayed. If you make a change in
one window, it also will be reflected in the second window.

Note the small floating toolbar in the screenshot on the next page. It includes a button to
Close one of the windows and return to just one view of your spreadsheet.

To turn off the Split, go to Window, then Remove Split. Similarly, there is an option in
the Window menu to Unfreeze Panes.
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Hide and Seek
Another way to control what areas
of your worksheet you can see is to
Hide rows or columns.

Let's say you wanted to only see
data about the Proposed Budget.
Rather than delete data for the
Current Budget, you can just Hide
that information. To do this,
highlight the columns or rows you
want to hide–in this case,
Columns B and C–right-click the
selected area and select Hide.
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The columns or rows you hide really don't go anywhere. Excel just sets the width or
height for those columns or rows to zero.

To get them back, highlight the rows or columns that are on either side of the rows or
columns that are hidden (Columns A and D), right-click the selected area and select
Unhide.

Moving On
You already know you can copy, cut and paste
data. You also can drag and drop individual cells or
a block of cells. To do this, highlight the data you
want to move, and point your cursor to the thick
black outline of your selected data, and your
pointer will become a four-way arrow. (See
screenshot to left.) When this happens, click and
hold down the left mouse button and drag the data
to the desired location.

Deleting Data
There are two ways to get rid of data, depending on what you want to do. If all you want
to do is erase the contents of a cell, block of cells, row or column, just highlight the area
you want to clear, right-click that area and select Clear Contents. This leaves the cells
intact but clears the data.

The other way to get rid of
data is to physically remove
both the data and the cells
from the table. When you do
this, data around the affected
area must shift up or to the
left to fill in the area you
deleted.

To do this, highlight what
you want to get rid of, right-
click that area and select
Delete.

If you are deleting a row or
column, that row or column
will be deleted without
requiring you to do anything
else. If you are deleting a
cell or a block of cells, a
window opens requiring you
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to pick one of four options. The first two determine whether data to the right of or
underneath the cells you are deleting will be shifted to fill in the deleted cells. The other
options are used to delete entire rows and columns rather than just the highlighted cells.

Somebody Save Me
Excel has an option called Autorecover that saves a copy of your file at whatever time
interval you specify. Note, however, that it does not save your actual file. It just saves a
copy. This means that the only time you can be sure you are saving your work is when
you click Save yourself.

The purpose of Autorecover is to limit how much work you'll lose if Excel crashes. When
this happens and you re-open Excel, the program will show you the files that were open
at the time of the crash and were saved. To set the Autorecover options, go to Tools, then
Options, and click the Save tab.

One thing you need
to keep in mind
about Autorecover
is that it is not the
same thing as
backing up your
files. It's only good
for recovering data
lost because of a
crash. When you
exit Excel normally,
those nice files are
deleted, so you
can’t recover them 
if you forgot to save

your work or if your files become corrupted.

You also can tell Excel to always create a Backup of your work when you save your file,
but it's not under Tools/Options where you'd expect to find it. Instead, go to File, then
Save As. When the Save As dialog box opens, click Tools near the top-right corner and
select General Options.
(See the screenshots on this
page.) From here, you can
check a box to tell Excel to
always create a backup.
The backup will be saved in
the same location as your
main file. The filename will
be the same, prefixed with:
"Copy of"
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While we're here, let's take a look at a couple of other ways you can protect your files:
Passwords and Read Only.

You'll see on the same dialog with a checkbox for Backup files, there also are two
textboxes where you can enter passwords. One is a password that must be entered just to
open the file. The second is a password that has to be entered only if the person wants to
Save the file. If you click the Advanced button, you can go a step further with encryption.
Finally, the lightest form of protection is the Read-only recommended textbox. When you
check this option, Excel will recommend, when the file is opened, that it be opened in
Read Only status to prevent accidental changes to the file. This simply means that it can't
be saved over the existing file. The user, however, can ignore the recommendation and
open the file normally.

Locking Cells and Validation
Two other ways to protect your data are to lock your worksheet and Data Validation. This
is easier to understand by taking a look at your options, so go to Tools, then Protection,
then Protect Sheet.

This opens up a small window that lets
you check off the things users can do in
the sheet while it's protected. The
checkbox at the top left of the window
prevents users from changing any cells
that are locked. To unlock the worksheet, a
user only has to go to Tools, then
Protection, and select Unprotect Sheet
unless you also specify a password here. If
you do this, the sheet can be unlocked only
with the password.

But which cells are locked? Select the
cells you want to lock, right-click the
highlighted area and select Format Cells.
Click the Protection tab, and you'll see a
checkbox marked Locked that you can
check to lock these cells. Note, however,
that locked and unlocked cells function
exactly the same UNLESS you protect the sheet. (Don't worry too much about Format
Cells right now. We're going to cover it in much more detail in the Intermediate tutorial.)

Another way to protect your data is Data Validation. This just means that you are setting
up parameters for what can be entered in a particular cell. This is particularly useful for
data entry.
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Let's try an example.If you have the city budget file open, close it. (You don’t have to 
save the changes if you don’t want to; we will not be using that file any more in this
tutorial.) Then open the Crime2.xls file.

This is a summary of all crimes reported to Allentown police over the course of several
years. The first column is the Uniform Crime Reports code for a particular crime. The
second column is a UCR-class code (which is used to group different UCR codes into
broader categories). The third column is a description of the crime, and the last column is
the number of times a particular crime was reported.

You could add a column where you classify each crime as Violent, Property, Traffic,
Nuisance or Other and put those entries in a dropdown menu. To do this, we will use
Data Validation.

First highlight the cells you want to protect. We are going to put this data in Column E,
so go to E1 and type the heading CRIME_TYPE. Next, select cells E2 through E376,
then select Data, then Validation from the Menu Bar.
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From the Validation window that opens, you can set requirements such as that the input
must be a whole number, a valid date or time or a text string with the maximum length
you specify. If a cell or group of cells has a small number of valid entries, you can select
List and type all of the valid entries in the Source box, separated by commas. There’s also 
a checkbox you can check to display all of these valid values in a dropdown menu.

Select “List” from 
the Allow
dropdown menu,
make sure both the
Ignore blank and
In-cell dropdown
boxes are checked,
then click on the
text window for
Source and type
(without spaces
after the commas):
Violent, Property,
Traffic, Nuisance,
Other (If you’ve 
done everything
correctly, the Data
Validation window
should look like

this screenshot.)

Click OK, then
click on any of the
cells in Column E
and you will see
that you now get a
dropdown menu.
You also will see

that Excel will not let you input something that isn’t in the dropdown menu. If you try, 
you will get an error message.

If you go back to the Data Validation window, you will see there are options to ignore
blank cells and to control messages users see when they are about to enter data into a cell
with validation and what they see when an error occurs. If you want to remove validation,
select the cells, go to Data, then Validation, and select Any value from the Allow
dropdown menu.

Feel free to play around with the dropdowns. We will not be using them again for this
exercise. When you are done, click E to select the entire column, right-click and select
Delete to get rid of it.
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Ranking Things
Let's say we want to add a column we can use to rank each crime by how often it occurs.
In other words, the crime that occurs most often will be 1, the crime that occurs the
second most often will be 2, and so on. Let's put this in Column E. We'll start by giving
this new column a heading, so click on Cell E1 and type the word RANK.
But how are we going to get these numbers in the right order? You learned this in the first
part of the tutorial: We're going to Sort the data. Just click somewhere in your data, and
select Data from the Menu Bar, then Sort. Excel automatically should highlight all of
your data except the first row. If you look at the Sort dialog box that opens, you'll see that
Excel has guessed correctly the first row is a Header Row.

We want to sort by the count of each crime, so sort by UCR_COUNT. We want to have
the most common crime at the top, so we also have to select Descending Order. We don't
want to sort by any other columns, so if any of the other two Sort By dropdown menus
have anything in them, select (none) in those menus. When you're done, click Sort. You
learn that the most common crime (or call to police, rather), is: Alarm Ringing–Fire or
Burglar

The next part is easy: Go to Cell E2 and type a 1, then go to Cell E3 and type a 2. When
you're done, highlight these two cells and double-click your Autofill handle in the
bottom-right corner of the selected cells. Excel automatically will put the rankings in for
the rest of your data. If you scroll all the way to the last row–Did you remember
Ctrl+End–you will see the rankings go from 1 to 375.

Why did you have to type a 1 and a 2 to get Excel to fill in the rest of the rankings? If you just put a 1 in the
first cell, Excel would put a 1 in every cell.

When you first opened the Crime2.xls file, did you remember the very first step you
always should take with a new data file: Save a copy. If you didn’t, save it now. 
Remember to give it a different file name and to select Save As from the File menu rather
than Save.

Subtotals
Excel can calculate subtotals for you. For example, we can add up the number of crimes
that occur for each UCR Class.

The first thing we need to do is Sort our data by the column that we want to use for our
Subtotals, so we will sort by UCR_CLASS. Technically, this is all we have to do, but to
make our data easier to read, we’ll also sort by UCR. See if you can figure out what to
do. If you get stuck, the screenshot on the next page will show you how to set up your
Sort box.
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First, you go to Data, then Sort in
the Menu Bar. We need to sort by
UCR_CLASS in Ascending order,
then by UCR, also in Ascending
order. The header row button
should be selected, and once this is
done, Row 1 in our worksheet
should not be part of the selected
data.

Click OK. If you did everything
correctly, MURDER/NON-
NEGLIGENT MANSLAUGHTER
should be in Row 2.

Now we’re ready to tell Excel to 
calculate Subtotals. Click Data on
the Menu Bar, then Subtotals. This

will open a dialog box. The first dropdown menu tells Excel when to calculate Subtotals.
In this case, we want a subtotal every time UCR_CLASS changes. Next we tell Excel
what function to use. The default is Sum, but if you open this dropdown menu, you’ll see 
we have many other choices, including Count (for the number of rows with each
UCR_CLASS), the lowest (Min) and highest (Max) values, the Average and even the
Standard Deviation. In the next box, we put a checkbox in UCR_COUNT because this is
the field we want Excel to add up for each Subtotal.

There are checkboxes that let you
replace the current Subtotals, if
you already have Subtotals in your
worksheet; to put page breaks
between each change in the
UCR_CLASS to keep all your data
together if you print it out; and to
put a Grand Total at the end of
your data (Summary below data).

Note the Remove All button at the
bottom of the window. You can
click this if you just want to
remove existing Subtotals.

If your Subtotal window looks like
the dialog box in the screenshot, to
the right, click OK.
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Notice the thick grey bar that appears to the left of your Row numbers. (See the
screenshot above.) The numbers 1, 2 and 3 at the top of this bar let you filter your
information.

The 1 just shows you the Grand Total, the 2 shows only Subtotals and the Grand Total,
and the 3 shows all of your data. If you are viewing just your Subtotals or all your data,
you will see boxes with + and–signs in the grey bar area. These can be used to expand
and collapse individual groups of data. For example, if you click on 3 to see all your data,
then click on the minus sign to the left of Row 4, Rows 2 and 3 will be hidden, you will
see only the subtotal for these rows, and the little box will change to a + sign that you can
use to expand this group and make the two missing rows visible again.

We will not need Subtotals any more for this exercise. See if you remember how to turn
them off before reading on. But first, let's go over a few more tips that show you how to
use some more of Excel's features.

Being Selective
You already know you can click and drag your mouse to select a block of cells. Let's look
at two other ways to select data.

First, if you want to select a large block of cells without having to highlight them
manually, click a cell in one corner of the block, hold down the Shift key, then click the
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cell in the opposite corner. So if, for example, you want to select the first 1000 rows, and
there is data in Columns A through J, you could click Cell A1, hold down the Shift key,
then scroll to and click J1000 (the top-left and bottom-right cells in the block). The whole
block will be highlighted.

Here's an even easier way to do the same thing. Re-using the same example, after you
click Cell A1, notice that just above your worksheet on the left edge of the screen is a
small textbox with A1 in it. Click in this box, type J1000, hold down the Shift key and
press Enter. Excel jumps to J1000 and highlights everything in between. This box also is
a handy way to jump to a particular cell much more quickly than scrolling. Just type the
address of the cell you want to get to and press Enter.

You also can highlight cells that are not contiguous. For example, if you want to
highlight cells A1 through A5 and C1 through C5, just highlight the Column A cells
normally, hold down the Ctrl key, then highlight the Column C cells.

Escape Plan
If you click on the wrong cell, start typing and erase what was there, you have two ways
to get it back. The first is to click the Undo button on the Standard toolbar (or choose
Edit, then Undo). If you are still in the cell you accidentally changed and haven't pressed
Enter yet, you also can just press the Esc (Escape) key, which is at the top-left of your
keyboard. Excel will dump your changes and put back the data you erased.

No Comment
You can write notes to yourself and other users. This can be useful to explain the data
contained in a row or column more than with just a heading. You might have details
about data manipulation or warnings about how to use the data correctly. To do this,
right-click the cell where you want to place the note and select Insert Comment. A small
window that looks like a yellow sticky note will appear for you to type the information.

You'll note that a small red triangle appears in the top right of the cell to tell you a
comment exists there. If you hover your mouse over that cell, the comment will pop up.
If you want to edit the comment, right-clicking the cell gives you an Edit Comment
option. From the same menu you also can choose Show/Hide Comments to have
comments always display rather than just when you hover your mouse over a cell. To
remove a comment, right-click the cell and select Delete Comment.

How Do You Spell Accumulate?
Spell-checking? In a spreadsheet?

Yep.

Go to Tools in the Menu Bar and select Spelling.
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Printing Your Work
OK, now let's move
on to something a
little more practical:
How do you print
out your work?
Many times, you
might not want to,
since a large sheet
could be split
among dozens or
hundreds of sheets
of paper. But you
can specify small
areas to print, or
maybe you've
boiled everything
down to a small
chart that will fit on
a page or two, and
you want to print it out to give to the desk, your editor or the graphics folks.

Before you print,
you should take a
look at the Page
Setup dialog, which
you can find in the
File menu. Let's
take a brief look at
each tab to see
what you can do:

Page: There are
buttons here to go
straight to the Print
dialog box or to see
a preview of what
your pages would
look like if you
printed with the
current settings.

The Options button lets you set printer options, such as what paper tray to use and
whether to use color. There also are options to put more than one page on a sheet of paper
or to print in reverse order (from the last page to the first).
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On the Page tab itself, you can set Portrait or Landscape printing. You also can use the
Scaling section to shrink or blow up the data or force Excel to limit the printing to a set
number of pages.

Margins: On this tab, you can set all the margins, as well as margins for headers and
footers, if you use them. Note the checkboxes at the bottom of the window. Normally
Excel will put data in the top left corner of the page. If your data won't fill up the whole
page, you can use one or both boxes to center your data horizontally and/or vertically.

Header/Footer: From this page, you can specify the text for headers and footers.

Sheet: The last tab
has some of the
most powerful
options. In the first
textbox, you can
specify the area you
want to print if you
don't want to print
all your data. To
make this easier,
you can click the
icon to the right of
this textbox. (The
mouse pointer is
pointing to this icon
in the screenshot.)
This will minimize
the Page Setup
window while you
select your cells. This window will minimize automatically, though, if you start to
highlight cells in your worksheet. As soon as you finish selecting the area you want to
print, you can click this icon to see the Page Setup dialog box again.

The Sheet tab also has options to select rows or columns to print on every page. (This is
how you can print column and row headings on every page.) There also is a checkbox to
make sure you can see the gridlines on the printout. If you don't check this box, Excel
will not print the gray lines you see on your screen around each cell. You also have
options to control whether and how Comments and Errors will be printed, and you can
specify the order in which Excel will print the pages. An illustration in this section shows
you what each Page Order option means.

One other tool that might be useful for printing is Print Area, which can be found under
the File menu. This is useful if you know you want to print a particular area of your chart
every time. For example, if you have a table of statewide school data but you only care
about schools in a particular county, you could sort your data by county, highlight the
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data you care about, then go to File, Print Area, Set Print Area. Excel will draw a dotted
line around that data, and the next time you select print, Excel will default to that area. If
you want to change that later, just select File, then Print Area, then Clear Print Area.

Finally, there is the
Print menu itself.
From here, you can
select which printer
you want to use,
what pages you
want to print and
whether you want to
print just data
you've selected (To
use this option,
select the data you
want to print before
you open the Print
window.), the
worksheet or all
worksheets in the

workbook. You also can specify the number of copies you want, whether to print to a file
rather than paper and whether to Collate the printouts.

The Laws of Averages
If you don’t have a copy of Sarah Cohen’s Numbers in the Newsroom on your desk (or at 
least available in your newsroom), you should. It has all those handy formulas you hate
but need to know.

Let’s talk briefly about a few of them now, namely averages. First of all, this is a
deceptive term because there is more than one way to calculatean average. Let’s look at 
three of those ways and how to calculate them in Excel.

Before we continue, though, were you able to figure out how to turn off Subtotals? If not,
here’s what you need to do: Select Data on your menu bar, then Subtotals. On the dialog 
boxthat opens you don’t have to do anything other then click Remove All.

Now let’s look at three kinds of averages:
 Mean: This is what people generally mean when they say “average.” You just 

add up all the numbers and divide by the number of numbers. Excel has a function
to calculate this: AVERAGE()

 Median: Another way to calculate averages is to list all your numbers from
lowest to highest and pick the middle number. If you have an even number of
numbers, you pick the middle two numbers, add them together and divide by two.
This method helps prevent extremely high and extremely low numbers from
skewing the average. The Excel function to calculate this: MEDIAN()
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 Mode: This is simply the number that occurs most often in your data. The Excel
function is: MODE()

Let’s try these out: Go to the bottom of your data. Skip the first blank row, which should
be Row 377, and click on the second black cell in Column C, which should be C378.
Type Mean. In the two cells underneath, type Median and Mode.

Now go to Column D, and using the information above try to figure out on your own
what you have to type for each function. If you do it right, your answers will be 720.936,
33 and 1.

Did you get stuck? If so, here are two hints: What is the first key you always have to type
when entering a formula or function? Second, each function takes only one argument,
which is the range of cells you want Excel to use for its calculations. In this case, your
numbers are in Cells D2 through D376.

OK, here are the formulas you needed to enter to calculate each kind of average:
 Mean: =AVERAGE(D2:D376)
 Median: =MEDIAN(D2:D376)
 Mode: =MODE(D2:D376)

You can see that each of these “averages” is vastly different from the others. Which one
you use depends on your data and what kind of average you’re looking for. See Sarah 
Cohen’s book for a much more thorough discussion of averages.

Rates
Rates are something you can use to help you compare two things. For example, if we
want to compare the crime in two cities, looking at just the number of times a particular
crime occurs in each city might not be a valid comparison if the cities' populations are
vastly different. Adjusting for population–by calculating crime rates for each city–will
get us closer to comparing apples to apples.

The nice thing about being able to use Excel is we can write a formula to calculate the
rate for one crime, then copy that formula to the rest of our data.

Let’s say we want to calculate the number of crimes per 100,000 people. The formula for
this is:

(Actual # of crimes * 100,000) / Population
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Let’s calculate Allentown’s crime rate per 100,000 people for each type of crime, and 
let’s assume Allentown’s population is 150,000. We’re going to put this information in 
Column F. Let’s give this column the heading CRIME_RATE. Next, go to F2 and see if 
you can figure out how to write the above formula in Excel. Round to one decimal place.
When you’re done, copy your formula down through the rest of your data. Don’t continue 
reading until you’ve tried to write the formula.

Did you get it? If you did everything correctly, the Murder/Non-Negligent Manslaughter
rate is 126.7.

If you had trouble, remember that you always have to type an = first. You also need to
remember your parentheses, and you need to use * for multiplication and / for division.

OK, let’s take a look at the formula to use:

=(D2*100000)/150000

Tip: There is a best practice that I am ignoring here, namely that you should never hard-
code any numbers. By that, I am referring to the 100,000 and the 150,000 in the formula.
A better way is to put these numbers in a cell somewhere, such as at the top of your data
or even on a separate worksheet. That way, if I ever need to change either number (such
as to calculate the rate for every 10,000 people or to adjust the city’s population), I only 
have to change those numbers in one place. If I had these two numbers in cells A1 and
A2, for example, my formula would be:

=(E2*$A$1)/$A$2

Note the use of the dollar signs. Do you remember what they are for? They will keep
Excel from changing these cell references when you copy the formula. Without them, if I
copied the formula down to the next row, that new formula would refer to cells A2 and
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A3. The $ signs ensure Excel always will look at these two cells, even if I copy or move
the formula.

Teaching Someone to Fish
Relax. You’re almost done with the Basic tutorial, and by now you should know enough
to comfortably use Excel and navigate around on your own to discover features you
haven’t learned about yet.

One way to get help is the Office Assistant. You can turn it on and off by going to the
Help menu. When the assistant is active, it will proactively try to help you with tasks it
thinks you are trying to accomplish and make suggestions. If you find the assistant to be
more annoying than helpful, you can turn it off in the Help menu.

A more useful tool is Microsoft Excel Help, which also is under the Help menu. Here you
can get help not only from the software’s help file, but also online from the Microsoft 
Web site.If you encounter an error you don’t understand or a function you don’t know 
how to use, or if you are not sure how to do something, Help is a good route to go. There
is a search box at the top of the Help window. Just underneath this is a link you can use to
browse the Excel help file’s table of contents. Farther down in the window are links to 
sites where you can download template files or search for training.

That’sIt!
You’ve finished Basic Training. But don’t stop here. Details on Excel’s most powerful 
features–pivot tables, filtering, the IF function, importing data from the Web and
functions to clean up text–are in the Intermediate tutorial. So take a break, but then
come back because all the coolest stuff lies just ahead.


